QUICKBOOKS DESKTOP 2021 CLIENT TRAINING

Lesson 9
Analyze Financial Data

Copyright

Copyright 2021 Intuit, Inc.
All rights reserved.

Intuit, Inc.
5601 Headquarters Drive
Plano, TX 75024

Trademarks

©2021 Intuit, Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte,
ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered
trademarks of Intuit, Inc. in the United States and other countries. Other parties’ marks
are the property of their respective owners.
Notice to Readers

The publications distributed by Intuit, Inc. are intended to assist accounting
professionals in their practices by providing current and accurate information.
However, no assurance is given that the information is comprehensive in its coverage
or that it is suitable in dealing with a client’s particular situation. Accordingly, the
information provided should not be relied upon as a substitute for independent
research. Intuit, Inc. does not render any accounting, legal or other professional
advice, nor does it have any responsibility for updating or revising any information
presented herein. Intuit, Inc. cannot warrant that the material contained herein will
continue to be accurate nor that it is completely free of errors when published.
Readers should verify statements before relying on them.

Lesson 9 — Analyze Financial Data

Table of Contents

Table of Contents
About the Author ....................................................................................................................... 4
Lesson Objectives ...................................................................................................................... 5
Create QuickReports ................................................................................................................. 6
Zoom in on a QuickReport ......................................................................................................... 8
Customize QuickReports ........................................................................................................... 9
Use the Report Center ............................................................................................................. 13
Create a Balance Sheet Previous Year Comparison Report...................................................... 16
Filter Reports ........................................................................................................................... 19
Save Reports as PDFs............................................................................................................... 22
Use QuickZoom in a Report ..................................................................................................... 23
Memorize Reports ................................................................................................................... 25
Create Memorized Report Groups ........................................................................................... 27
Print Reports............................................................................................................................ 30
Process Reports in Groups ....................................................................................................... 31
Process Multiple Miscellaneous Reports ................................................................................. 33
Send a Report to Excel............................................................................................................. 34
Create an Income and Expense Graph ..................................................................................... 36
Use QuickZoom with Graphs ................................................................................................... 38
Customize How Graphs Display............................................................................................... 40
Analyze Financial Data — Review Questions ............................................................................ 42
Review Activities ..................................................................................................................... 43
Answers to Review Questions ................................................................................................. 44

QuickBooks Desktop 2021 Client Training

3

Lesson 9 — Analyze Financial Data

About the Author

About the Author
Esther Friedberg Karp, MBA
President, EFK CompuBooks Inc.
esther@e-compubooks.com

Esther Friedberg Karp is an internationally renowned trainer, writer, business consultant and speaker
who has been repeatedly listed as one of Insightful Accountant’s Top 100 QuickBooks ProAdvisors
in the world. She has also been named to their Top 10 list on two occasions: as Top International
ProAdvisor and Top Trainer/Writer ProAdvisor.
Based in Toronto, Canada, Esther has the unique distinction of holding ProAdvisor certifications in
the United States, Canada and the United Kingdom. She has authored materials and delivered
educational and certification courses for Intuit in all those countries, as well as Australia where she
conducted live QuickBooks Online training. She has spoken at Scaling New Heights, QuickBooks
Connect and other conferences, and has written countless articles for Intuit Global.
Esther’s clients include companies worldwide and accounting professionals who seek her out on
behalf of their own clients. She is sought out for her expertise in multicurrency and various countries’
editions of QuickBooks Desktop and Online, and for her talent in customizing QuickBooks usage for
different industries. She also teaches QuickBooks Core and Advanced certification classes to
accounting professionals in Canada.
Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA
in Marketing and Finance from York University’s Schulich School of Business.
She can be reached at esther@e-compubooks.com or 416-410-0750.

QuickBooks Desktop 2021 Client Training

4

Lesson 9 — Analyze Financial Data

Lesson Objectives

Lesson Objectives
some of the tools in QuickBooks for analyzing financial data: QuickReports, preset
• Discuss
reports and graphs

• Create a QuickReport
• Add a column to a report
• Learn how to move a column in a report
• Learn about the types of preset reports QuickBooks offers
• Practice creating reports and viewing them onscreen
• Customize a report by changing how it looks and the data it covers (filtering)
• Learn how to process reports in batches
• Save reports as portable document format (PDF) files
• Learn how to export a report to Microsoft Excel®
• Practice filtering reports in Excel
• Learn about the types of graphs QuickBooks offers
• Create and customize several graphs

QuickBooks Desktop 2021 Client Training

5

Lesson 9 — Analyze Financial Data

Create QuickReports

Create QuickReports
One of the fastest ways to see a report on your QuickBooks data is to create a QuickReport.
QuickReports are predesigned reports that give you information about the list name you’re currently
viewing on screen. Whenever you have a list, register or form displayed, you can click a button to
have QuickBooks create a QuickReport.

Step-by-Step: See What You Owe a Vendor
1. Click Vendor Center on the icon bar.
2. Right-click on the vendor name you wish to run a report for and select QuickReport or click the
QuickReport hyperlink in the Vendor Information section on the right.
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Create QuickReports

3. You can expand the date range to capture more transactions on your QuickReport. You’ll see
other ways to customize the QuickReport later in this lesson.
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Zoom in on a QuickReport

Zoom in on a QuickReport
All QuickReports contain a list of individual transactions. To help you better understand the
information presented in reports, QuickBooks lets you trace report data to the individual transaction
level using QuickZoom.
When you position the mouse pointer over an entry in a report and see the QuickZoom symbol (a
magnifying glass with a Z in it), you can double-click the entry to display the original transaction in
QuickBooks.

Step-by-Step: See more Detail about a Transaction
1. From any report, hold your cursor over an entry you wish to view in more detail.
2. When your cursor turns into the QuickZoom icon, double-click your mouse to zoom in. This will
open the transaction.

3. Press Esc to close the window.
NOTES
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Customize QuickReports

Customize QuickReports
Each QuickReport window has a button bar at the top of the report for customizing report content
and layout.

Step-by-Step: Add a Column to a Report
1. In the QuickReport window, click Customize Report.
2. In the Columns list, select the additional columns you would like to add to the report by clicking
and adding a checkmark (in this example, we marked the Trans # column). If there are any
columns you do not wish to see, de-select the checkmark next to that column in the list.

3. Click OK to accept the change.
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Customize QuickReports

Notice the additional column(s) in your report.

Step-by-Step: Move a Report Column
1. Position your mouse pointer over the column you wish to move (the mouse becomes a hand).
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Customize QuickReports

2. Hold down the left mouse button and drag the column header/name to the position you would
prefer. When a red arrow appears, release your mouse button if you want the column to appear
in this new position.
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Customize QuickReports

Step-by-Step: Change Information in the Report Heading
1. In the report window, click Customize Report then click the Header/Footer tab.

On the Header/Footer tab you can change the company name, report title, subtitle, and date
and time prepared. You can also specify whether to print the header on all pages or just the first
page. The Header/Footer tab is the same for all QuickBooks reports.
2. Highlight the text in the Report Title field and replace it with the title you would like.
3. Click OK to close the Modify Report window.
4. Close the report.

IMPORTANT: To save this report for future use, click the Memorize button on the report tool bar before
closing the report. This allows you to save the custom settings and run the report with the new settings
later from the Reports drop-down menu.

NOTES
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Use the Report Center

Use the Report Center
A good way to learn about the reports available in QuickBooks — and how to work with them — is the
Report Center.
The Report Center contains a description and example of each QuickBooks report. You can click the
icons at the top right corner of the Report Center to select the display format you prefer.

Step-by-Step: Learn More about Reports
1. Click Reports on the icon bar (or under the Reports menu), and then click Report Center.
2. Use the blue view icons in the top right corner to customize your view.

GRID VIEW
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Use the Report Center

LIST VIEW

CAROUSEL VIEW
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Use the Report Center

3. Click the Contributed tab at the top to open Contributed Reports, an Intuit web page where you
can search, review, download and import additional reports. Review the information, then close
the window.
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Create a Balance Sheet Previous Year Comparison Report

Create a Balance Sheet Previous Year
Comparison Report
The profit & loss comparison report compares the current year against the previous year in both
dollar amount and percentage.

Step-by-Step: Create a Balance Sheet Previous Year Comparison Report
1. In the Report Center, choose List View in the top right corner. Then click the Standard tab and
choose Company & Financial, scroll down and choose Profit & Loss Prev Year Comparison.
2. Click the Run icon.
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Create a Balance Sheet Previous Year Comparison Report

Scroll down the report window to see more of the report.
3. Click the Collapse Rows button in the top right section of the report to see the difference.
The Collapse Rows button hides rows related subaccounts (as well as jobs and subclasses,
depending on the report). Amounts are summarized under the parent name. This button affects
both the onscreen and printed report.
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Create a Balance Sheet Previous Year Comparison Report

4. Click Expand Rows in the top right section of the report (where the Collapse Rows button had
been) to return to the original report display.

5. Close the report.
NOTES
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Filter Reports

Filter Reports
You can customize reports in QuickBooks to highlight just the information you’re interested in
getting. In this exercise, you’ll customize the balance sheet comparison report and filter it to include
only the transactions you specify.
Report filters let you set custom criteria for the transactions you want included in a report. When you
filter a report, QuickBooks includes only those transactions that match the rules you create.

Step-by-Step: Filter a Preset Report
1. With the Profit & Loss Prev Year Comparison report displayed, click Customize Report at the top
left of the report.
2. Click the Filters tab.
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Filter Reports

3. In the Filter scroll box, choose the filters for which you want to set your parameters and set your
specifications.
4. To remove or modify an existing filter, highlight it in the Current Filter Choices section, and either
modify the filter or click Remove Selected Filter below that section.
5. Click OK.
6. You can review what filters have been applied directly on any particular report by clicking Show
Filters in the top left corner of the displayed report. Once you have done that, you can click on a
filter to change it, or click on the X next to the filter to remove it. When printed, reports with
Applied Filters displayed will print the filters on a separate page. You can also click Hide Filters
(where the Show Filters button had been) to hide the list of filters.
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Filter Reports

NOTES
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Save Reports as a PDFs

Save Reports as PDFs
To keep a record of the information in the report as it exists today, you can save the report in
portable document format (PDF).

Step-by-Step: Save a Report as a PDF File
1. With the report open, choose Save as PDF from the File menu. (You can also click on Print 
Save as PDF at the top of the displayed report.)
2. Navigate to the folder where you want to store the PDF and enter a file name.
3. Click Save.
4. Close the report window.

IMPORTANT: if you wish to send the report as a PDF attachment to an email in one step without saving it
as a PDF first, select Email  Send report as PDF. (QuickBooks will not allow you to select the Send
report as PDF option if you are using a sample company.)

NOTES
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Use QuickZoom in a Report

Use QuickZoom in a Report
Step-by-Step: QuickZoom on a Listing in a Report
1. Position the mouse pointer over the listing you wish to view in detail.
2. Double-click the amount. What you see when you QuickZoom in a report will depend on the
type of report displayed.
a.

If the report shows summary figures (like the Sales by Customer Summary report below) and
you QuickZoom an amount…
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Use QuickZoom in a Report

b. …QuickBooks displays a detail report that includes the transactions which contribute to that

amount. You can then double-click on an individual transaction in that detail report to
QuickZoom on it.

c.

If you QuickZoom a transaction in a detail report, QuickBooks opens and displays the invoice,
bill or other form for the requested transaction. At this point you can review, delete or edit
the displayed transaction as necessary.

NOTES
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Memorize Reports

Memorize Reports
You may want to memorize reports which you customize, filter and run frequently. Memorizing
reports can save you from spending time customizing the same reports over and over again.
Remember, memorizing reports saves your customizations and filters, not the data. As new data is
entered or existing data is changed, running a memorized report will display the refreshed data but
with the same settings (e.g., columns, title, etc.) you saved.

Step-by-Step: Memorize a Report
1. When you are in a report you would like to memorize, click Memorize from the report tool bar.

2. Name the memorized report accordingly.
3. Click the Save in Memorized Report Group checkbox if you would like to assign this report to a
group (you’ll see more about memorized report groups in the next section), then choose the
group from the drop-down menu.

4. Check the box next to Share this report template with others if you wish to offer this
memorized report (the settings, not the data!) to the entire Intuit community to help others who
may have a need for business information similar to yours in their own QuickBooks company
files.
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Memorize Reports

5. Click OK to memorize the report.
If you selected the checkbox for Share this report template with others, you’ll see a Share
Template window appear, in which you can add more information about this report (be sure to
click on both of the Basic Info and the Additional Report Info tabs). When you’re done and
you’re sure that you want to share this report’s settings to the community at large, select Share.

6. Close the report.
NOTES
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Create Memorized Report Groups

Create Memorized Report Groups
In addition to memorizing individual reports to save report settings, you can create memorized
report groups to organize your memorized reports in a way that makes sense for your business and
allows you to process a group of reports all at once.
QuickBooks comes preset with a number of memorized report groups, each already populated with
common reports for each area. You can add your own reports to these groups, modify the groups to
meet your needs and even create your own groups.

Step-by-Step: Create a Memorized Report Group
1. Choose Memorized Reports from the Reports menu then choose Memorized Report List.
2. At the bottom of the Memorized Report List, click Memorized Report  New Group.
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Create Memorized Report Groups

3. In the Name field of the New Memorized Report Group window, type Year End.

4. Click OK.

NOTES
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Print Reports

Print Reports
Step-by-Step: Print a Report
1. With a report open, click the Print button from the tool bar then choose Report.

2. Click Preview to see how the report will look when you print it.
QuickBooks displays a preview of your report onscreen.
3. Click Print.
4. Close the report.
NOTES
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Process Reports in Groups

Process Reports in Groups
Step-by-Step: Batch Process Reports in a Group
1. In the Memorized Report List, select the heading of the report group you would like to print.
2. Click Display.
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Process Reports in Groups

QuickBooks opens the Process Multiple Reports window. You can use this window to display or
print the selected reports (selected by the checkmark in the far left column next to the reports).
You can also change the date range for reports in this window before you display or print them
by changing the information in the From or To columns.

3. Select the reports you wish to print (by ensuring they have a checkmark in the left column and
remove the checkmark for any reports you don’t want to print) then click Display to review the
information in the reports or click Print to print all the reports.
If you choose to display the reports, you can print each report individually. Click the Print button
from each displayed report’s tool bar, then choose Report.
NOTES
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Process Multiple Miscellaneous Reports

Process Multiple Miscellaneous Reports
In addition to batch processing a group of reports, you can also batch process various selected
memorized reports that are not all in the same report group.

Step-by-Step: Batch Process Multiple Miscellaneous Reports
1. From the Reports menu, select Process Multiple Reports.
2. QuickBooks opens the Process Multiple Reports window. Select the memorized reports you want
to process (all reports from all groups are currently listed) by placing a checkmark next to the
desired reports. You can also change the date range for reports in this window before you
display or print them by changing the information in the From or To columns.

3. Once the desired reports are selected, choose Display to review the information in the reports
or Print to print the reports.
If you choose to display the reports, you can print each report individually. Click the Print button on
the tool bar for each displayed report, then choose Report.
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Send a Report to Microsoft Excel

Send a Report to Microsoft Excel®
Occasionally you may want to change a report’s appearance or contents in ways that aren’t available
in QuickBooks, filter report data in ways you can’t in QuickBooks, or run “what-if” scenarios on your
QuickBooks data.
You can send reports from QuickBooks to Excel. Since the changes you make in Excel don’t affect
your QuickBooks data, you’re free to customize reports as needed and even change data to run
“what-if” scenarios.

Step-by-Step: Send a Report to Excel
1. From the Reports menu, open the report you would like to convert to Excel.
2. On the Report button bar at the top of the report, set the Date parameters for your report. You
can use the Customize button to set additional filters and add additional customization.
If you clicked the Customize button in the previous step, and after you’ve specified your
additional parameters, click OK. Regardless, ensure the report data is now displaying using your
chosen customizations.
3. On the Report button bar, click Excel and Create New Worksheet (or you could select Update
Existing Worksheet if this report with these settings was previously sent to a spreadsheet that
was saved).
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Send a Report to Microsoft Excel

4. Click the Advanced tab to add custom export options of Auto Outline and Auto Filtering if
they’re not chosen already.

5. Click OK  Export.
NOTES
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Create an Income and Expense Graph

Create an Income and Expense Graph
If you want your business to be profitable, you need to keep an eye on your expenses. The income
and expense graph shows exactly what you’re spending and where.
You should be especially concerned with the proportion you’re spending on expenses relative to the
income you receive. As a simplistic example, if you’re earning only $20,000 in income, you don’t
want to spend $30,000 in expenses.

Step-by-Step: Create an Income and Expense Graph
1. From the Reports menu, choose Company & Financial  Income & Expense Graph. You will
see the top 10 expense categories listed with numerical information next to a key listing them
with their pie chart colors.
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Create an Income and Expense Graph

2. You can choose to categorize expenses By Account, By Customer or By Class from the report
tool bar at the top.
3. QuickBooks can display information on only 10 pie segments at a time. To display more
accounts, click the Next Group button at the top of the graph window.
4. You can change the date range by clicking the Dates button at the top.

Step-by-Step: Display Income Accounts Instead of Expense Accounts
1. Click Income at the bottom of the Income & Expense Graph window.
2. Choose to categorize income By Account, By Customer or By Class from the report tool bar at
the top (Income By Customer shown below).

NOTES
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Use QuickZoom with Graphs

Use QuickZoom with Graphs
To help you better understand the information shown in the graphs, QuickBooks lets you trace
graphical data using QuickZoom. This works the same as the QuickZoom functionality on report
entries described earlier in this lesson.

Step-by-Step: QuickZoom on Graphical Information
1. Position the mouse pointer over the section of the chart you wish to see in more detail, observe
the mouse pointer has turned into a magnifying glass with a Z in it, and double-click.
IMPORTANT: The QuickZoom report features will vary depending on the type of information you are
choosing to QuickZoom in order to get more details.
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Customize How Graphs Display

Customize How Graphs Display
You can customize graphs to control what data they include and how the data is displayed. In this
exercise you’ll change the display from three-dimensional (3D) to two-dimensional (2D) graphs.

Step-by-Step: Change from 3D to 2D
1. From the Edit menu, choose Preferences.
2. In the left panel click Reports & Graphs.
3. In the My Preferences tab, place a checkmark in the box next to Draw graphs in 2D (faster).

4. Click OK.
5. Open the Report Center.
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Customize How Graphs Display

6. Choose Sales  Sales Graph to view the effect of the change.
7. Click the Run (Display Report) icon.
8. Close the graph.
9. Close the Report Center.
NOTES
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Analyze Financial Data — Review Questions

Analyze Financial Data — Review Questions
1. _________________________ is the tool that allows you to drill down on summary reports and
graphs in QuickBooks.
2. When can you generate a QuickReport?
d. Only when viewing an active customer or account
e.

Only when viewing a list, register or form

f.

Only at the end of the current fiscal period

g. Only when viewing balance sheet accounts

3. In which report category would you find a list of open invoices?
a.

Company & Financial

b. Sales
c.

Customers & Receivables

d. List

4. Report _______________________ let you set custom criteria for the transactions you want to
include in a report.
5. Once you’ve customized a preset report to meet your needs, how can you save your settings so
you don’t have to customize the report each time you run it?
a.

Choose Save Settings from the Report menu

b. Choose Save Setting from the File menu
c.

Click Memorize

d. Click Modify then choose Memorize

6. True or false: Once you’ve exported report data to Excel, you can send modified data back to
QuickBooks.
a.

True

b. False
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Review Activities

Review Activities
Use Rock Castle Construction (sample product-based company) to do these activities:
1. Create a QuickReport on a name in one of Rock Castle Construction’s lists.
2. Rock Castle Construction wants to create a report that shows how much they have spent on
lumber for projects during November of the current year (the current year is whatever Rock
Castle Construction specifies is the current year based on the date you see when you open that
sample company). Create an item summary purchase report covering the date range for
November of the current year. Filter the report to show only Rock Castle Construction’s
purchases for lumber.
3. Batch process the balance sheet, profit and loss statement, and statement of cash flows using the
Process Multiple Reports window.
4. Use the Report Center to find reports that show the following:







Sick and vacation balances for each employee
Time spent on each job
Inventory stock on hand and reorder point
Customers with overdue payments, how much they owe and their phone numbers
How much of total sales is taxable, at what rate, and how much sales tax is currently due
to be paid
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Answers to Review Questions
1. QuickZoom is the tool that allows you to drill down on summary reports and graphs in
QuickBooks.
2. When can you generate a QuickReport?
a.

Only when viewing an active customer or account

b.

 Only when viewing a list, register or form

c.

Only at the end of the current fiscal period

d. Only when viewing balance sheet accounts

3. In which report category would you find a list of open invoices?
a.

Company & Financial

b. Sales
c.

 Customers & Receivables

d. List

4. Report filters let you set custom criteria for the transactions you want to include in a report.
5. Once you’ve customized a preset report to meet your needs, how can you save your settings so
you don’t have to customize the report each time you run it?
a.

Choose Save Settings from the Report menu

b. Choose Save Setting from the File menu
c.

 Click Memorize on the button bar

d. Click Modify then choose Memorize

6. True or false: Once you’ve exported report data to Excel, you can send modified data back to
QuickBooks.
a.

True

b.

 False
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